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€) BOHEMIAN CODING | @ skercH @ FONTCASE BLOG SUPPORT

Sketch

THE DESIGNER'S TOOLBOX

SKETCH STYLES SHAPES SLICES TEXT PIXELS


http://www.bohemiancoding.com/sketch/
http://www.bohemiancoding.com/sketch/

Acorn 4: Fluid Interface, Speed, Curves, Layer Filters & More

With a ton of new features and refinements, you will make beautiful images in Acom.

Learn to use Acom:

Download Acom 4.1 for OS X 10.8+
Tutorials, Documentation, & Release Notes

Buy Now: Flying Meat Store or Mac App Store

Everyone needs to edit images at some point, but not everyone has the time to learn complicated super pricey image editing programs. This
is why we created Acorn. Add text and shapes to your digital pictures. Combine images together to create your own. Work with layers to
touch up your favorite photos or make something new from scratch. Do all this and more with Acorn.

http://www.flyingmeat.com/acorn/

images to using Instant Al. create endless combinations of highlights, and contrast in your
everything is faster. unique effects knowing you can  images.
always change your mind later

on.


http://www.flyingmeat.com
http://www.flyingmeat.com
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Vector lllustration for OS X and iOS.
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LogIn

webflow

Design responsive
websites visually.

Password

Get started. It's freel

Co to App Store

https://webflow.com/

Pixel perfect design control.


https://webflow.com/
https://webflow.com/

Company Title

Feature 1

This is a feature

description. Donec
ullamcorper nulla non metus
auctor fringilia. Sed posuere
consectetur est at lobortis.

Feature 5

This is a feature
description. Donec

Feature 2

This is a feature

description. Donec
ullamcorper nulla non metus
auctor fringilia. Sed posuere
consectetur est at lobortis.

Feature 6

This is a feature
dascription. Donec

Nav Link 1

Navlink 2

NavLlink 3

Navlink 4

This is a heading

This is a description that describes this site. Vivamus sagittis
lacus vel augue laoreet rutrum faucibus dolor auctor. Donec id
elitnon mi porta gravida at eget metus. Cum sociis natoque
penatibus et magnis dis parturient montes, nascetur ridiculus

Action button

Feature 3

This is a feature

description. Donec
ullamcorper nulla non metus
auctor fringilia. Sed posuere
consectetur est at lobortis

Bution Text

Feature 7

This Is a feature
dascnption. Donec

Feature 4

This is a feature

description. Donec
ullamcorper nulla non metus
auctor inngilla. Sed posuere
consectetur est at lobortis.

Feature 8

This Is a feature
description. Donec
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FRCDNT Register Login

Responsive web design,
the visual way

Design websites directly in the browser with a simple drag and drop interface
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See how it
works

FROONT

http://froont.com/

- . coming
- The multi-device age is here. FROONT lets you design for all of them


http://froont.com/
http://froont.com/

............................

............................

THIS IS FROONT

With FROONT creating responsive websites is visual.

Check out how this website looks on different devices by clicking on the ruler above.

The fluid
nature of web

Design around
the content

See what you
are designing

Responsive design means Content is the main part of your Webdesign is hard! We aim to

Fill [] #o08a184
Stroke

Background B
color

Reset current breakpoint

Display
Position
Margin
Min-width
Max-width
Max-height
Float

Clear
Border

Border radius
WIDGETS

Header
Top logo
Top heading
Top description
Middle section
Middie grid
Info block 1
nfo image 1
nfo heading 1
nfo text 1
Info block 2
nfo image 2
nfo heading 2
nfo text 2

Info block 3

@ 0 & 0 0 0 0 9 00 00 0 0 & 0
m D H D DD DD OH®H OO 0050

nfo image 3
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cssnitedemo* - Edge Reflow CC (Preview)

Default

el

—
Ll

sectetur in mollit aute nulla culpa commodo fugiat
v 13 .!siusmod culpa nisi enim €5 1" agna consectetur esse
adipisicing commodo dolor anim mollit sit aute dolor amet in
rure.

F:om ipsum Dolor et dolore Excepteur magna non minim in '

Action Button

TT Tr

Feature 3
Lorem ipsum Dolor et dolore Lorem ipsum Dolor et dolore
Excepteur magna non minim in Excepteur magna non minim in

Feature 4

Lorem ipsum Dolor et dolore
Excepleur magna non minim in

Feature 1

Lorem ipsum Dolor et dolore
Excepteur magna non minim in

Adobe Edge Retlow
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cssnitedemo* - Edge Reflow CC (Preview)

55

i

Feature 1
Lorem ipsum Dolor et dolore Excepteur magna non
minim in consectetur in mollit aute nulla culpa
commodo fugiat eiusmod culpa nisi enim et aliqua
magna consecletur esse adipisicing commodo
dolor anim moliit sit aute dolor amet in irure.

Feature 2

T hd

Feature 1
Lorem ipsum Dolor et dolore Exceptaur
}magna non minim in consectetur in
;monit aute nulla culpa commodo fugiat
eiusmod culpa nisi enim et aliqua
;magna consectetur esse adipisicing
commodo dolor anim mollit sit aute
dolor amet in irure.

Lorem ipsum Dolor et dolore Excepteur magna non |
minim in consactetur in mollit aute nulla culpa
commodo fugiat eiusmod culpa nisi enim et aliqua
magna consectetur esse adipisicing commodo
dolor anim mollit sit aute dolor amet in irure.

Button Text

Default
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Foundation

B O Ot St ra p 3 (onkend BRTROr I e work

Sleek, intuitive, and powerful mobile-first f d framework

e AN e P et Download Foundation 4
web development

o 1) On sheegauer ¥ ot

Download latest BS3

Comeet ¢34 ARt e o0 Jutee | IS 2006w Chore Now

Looking for Bootstrap 2.2.2 doce® v o0 03 110 3 New hame sis we DA Vraand e Roots) Fead he Slog 'or oeta

GRAD project Fxarpies  Ghphicors Doctstrap Fxpo
Rasp0raive Gesign QNS Ser. Wsier nd Mmore MVINCSN. 50 yOU TN 0008 SMarter

- f P
Topcoat

PURE

Get Started View on GitHub



Bootstrap 3 RC2  Gettingstarted CSS  Components  JavaScript  Customize

Bootstrap 3

Sleek, intuitive, and powerful mobile-first front-end framework
for faster and easier web development.

‘ Download latest BS3 ‘

Heads up! Downloads are pulled directly from the latest committed code on GitHub, and as a result our docs may at times be out of sync.

Bootstrap

http://getbootstrap.com/


http://getbootstrap.com
http://getbootstrap.com

Features Add-ons Case Studies Docs Training
Getting Started

Foundation

The most advanced responsive
front-end framework in the world.

Download Foundation 4

% 13.0k stargazers W @foundationzurb

Foundation

http://foundation.zurb.com/

T Shiny New HTML


http://foundation.zurb.com
http://foundation.zurb.com

Pure

A set of small, responsive CSS
mModules that you can use in every
web project.

Pure

http://purecss.io/


http://purecss.io/
http://purecss.io/

CSSforclean and f:

AStL WeD apps.

x& | DETAILS |
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lopcoat

http://topcoat.io/

for performance. You can see our results. o componentswere born from CSS.



http://topcoat.io/
http://topcoat.io/
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/ Its black magic! Share it! Home . 17 3
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CSS Hat turns Photoshop layer styles to CSS3. Instantly.

Buy CSS Hat Now

100% money-back guarantee

$29.99

Photoshop CC supported!

CSS Hat

http://csshat.com/

How CSS Hat works?



http://csshat.com/
http://csshat.com/

CSS3Ps - free cloud based photoshop
plugin that converts your layers to CSS3.

CSS3Ps

http://css3ps.com/

9 ¢ = ﬂ_ —
\!"_ \ CSS3Ps

g+ 1 wTweet 3267 Muke 47« [CIRd 3e8



http://css3ps.com/
http://css3ps.com/

e DTPTransut 08 ©

h, 2 &.\F{L\ur ZDTP 1L—H —Di-8hlc Twitter RSS Facebook

b

lllustrator Photoshop InDesign Mac OS X tE274— RTFHE W8 hAS LR )

K—L4 » ZRE » lllustrator »
lllustrator CCOCSS&ZHLD/NT

wYAf—h 4 Gunk! 10

llustrator CCTIZ, CSSREHLEYR—MLTWET,

WebSEZfT>oTWAAIKES TR, BMEHITORWEBETTH, PREDTOETE—3vTH->TW
5&5BFER TEPHE; TY,

ADOBE TV

DIP lransit

http://www.dtp-transit.jp/adobe/illustrator/post_1731.html

w77 d
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http://www.dtp-transit.jp/adobe/illustrator/post_1731.html
http://www.dtp-transit.jp/adobe/illustrator/post_1731.html

< Return to Firewoiks

Extensions, resources & tutorials for Fireworks, Dreamweaver & HTMLS / CSS3 by Ul developer, Matt Stow.

Fv] Adobe Fireworks o« Adobe Dreamweaver 5 J Web Standards

CSS Professionalzr vi.1
Posted: August 12013

Fireworks CS6 introduced a fantastic feature with the CSS Properties panel. It allows the user to copy an
element’s attributes as CSS3 to make the build process more efficient. it doesn't produce the cleanest, most
professional code, however, so I've written CSS Professionalzr to do it for you.

® Watch a screencast of Fireworks CS@'s CSS Properties panel and CSS Professionalzr in action
® v Download CSS Professionalzr vi.1

This latest update has the following changes:

® Fixed gradient angles & SVG generation after 12.0.1 update
e Added support for 8 other SVG angles.
® Removed legacy syntaxes for border-radius & gradients

If you've upgraded Fireworks to 12.0.1 you need CSS Professionalzr v1.1, otherwise your gradient angles will
be incorrect
Its features (in order)

® Formats all of the properties consistently (commas, colons, spaces etc) and removes redundant new lines

e Removes all IE filters (they shouldn't be used for various reasons. Use CSS3PIE if you must have the

CSS Professionalzr

http://mattstow.com/css-professionalzr.html

® Converts % border-radius to their px equivalents
e Converts all rgb(r.g.b) to their shorter hex equivalent (and the 3 char hex if applicable)

® Removes the leading O on rgba opacity values

a Al abhabdloaas all seilas


http://mattstow.com/css-professionalzr.html
http://mattstow.com/css-professionalzr.html
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Blog About Support

S by

Slicy truly reinvents Photoshop slicing. To export PSD elements as assets for your website or app,
rename your layer groups once and let Slicy do everything else. Designers and developers, rejoice!

;nl MInu:c > Free Download ¥ Buy for$29 @

macrabbit

Slice PSDs in a whole new way. It's so much better.

slicy

http://macrabbit.com/slicy/

Slicy exports layer groups independently, giving you total freedom to move,
v’ Wonderful for App, Web and icon design overlap or even hide design elements. Tagging for export is easy while

v Precision exporting, Inciuding transparency

v No grids or templates, Just use your mockup organizing your PSDs, and quickly saves you tons of time. You'l soon

v AuoSize or explicitly define areas 1o export avnariansas haas matiral thie rassank iararmam s redes wwiesr o aveenrdins o


http://macrabbit.com/slicy/
http://macrabbit.com/slicy/

Cut&Slice me

CutéSlice me

Cut&Slice me

A FREE Photoshop plugin

R

@ feedback.

< Cut All assets
" Export all groups as png

export your assets to different devices in
ut Subgroups

port all groups insl

seconds

Cut Selected

Export selected layer

VW IVINRWINW V.

app_logo.png|
app_logo@2x
bg.png '
bg@2x.png
btn_login_dis
btn_login_dis

<

Boost your Workflow

Not everyone name his layers properly.

Y¢ Yt hemham®

But if you have that discipline, you can export your assets in seconds.

Cut&Slice me

http://www.cutandslice.me/

® | >0 s Forget obsolete Photoshop Slices

® | PO passinput



http://www.cutandslice.me/
http://www.cutandslice.me/

CONTACT
ARCHIVE

Automate export of images from lllustrator

http://meridimus.com/post/3339295561 1/automate-export-of-images-from-illustrator-for-ios

® O §f v

OCT 12,2012


http://meridimus.com/post/33392955611/automate-export-of-images-from-illustrator-for-ios
http://meridimus.com/post/33392955611/automate-export-of-images-from-illustrator-for-ios

lustrator scripts | |~ | |-
for mobile design = =

Collection of lllustrator scripts to automatically export - Donate
layers or artboards to PNGs of different densities for (= | = e o | 20
different devices (i0S Retina, Android, etc).

W Tweet 0 L{-1 3

How to install

If you place the script in the Adobe lllustrator CS5/Presets/Scripts folder, the
script will appear in the File > Scripts submenu.

If you place the script in another location on the hard disk, you can run the script
in lllustrator by choosing File > Scripts > Browse.

How to use Mobile > General

The general scripts asks for 3 values in sequence:

1. The folder where you want to save the files.

2. The scale factor 1 = 100% = 160dpi = mdpi, 2 = 200% = 320dpi = retina display
(these values are only valid if you designed for 160dpi aka mdpi).

3. A sufﬁx if you want to use one, e.g., @2x for retina dnsplay m iOS. You can also

llustrator scripts for mobile

http://herkulano.github.io/illustrator-scripts-for-mobile/

How to use Mobile > Android

1. Choose the folder where you want to save the files.


http://herkulano.github.io/illustrator-scripts-for-mobile/
http://herkulano.github.io/illustrator-scripts-for-mobile/
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Retina Image Exporter
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oS N e

RetinBERB@=HL 29 v>O—FK

o EYIvO—-R mxpfERXEY I O—-RK

Retina Image Exporter

http://creative-tweet.net/tools/retina_image_exporter/detail.html

Fireworks TA 75z AL, BRRET /(1 AR ORROBE
UETSHERETYT, @1 XEROBBREEZ2(BICLELET, @G2xELTHE


http://creative-tweet.net/tools/retina_image_exporter/detail.html
http://creative-tweet.net/tools/retina_image_exporter/detail.html
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http://www.slideshare.net/MaruyamaAkira/okayama-gatinko


http://www.slideshare.net/MaruyamaAkira/okayama-gatinko
http://www.slideshare.net/MaruyamaAkira/okayama-gatinko
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Extensions Articles Library Labs

$ ’
- * b4 i » ’ -

» Creative Tools f:c;r Adobe Fireworks

Export

Home » Extensions » Commands » Export Stay connected: #§ 't [in |3

Export.mxp Export.zip (.mxp and jsf files) sharethis: {3 w/| SE3 22|

@ Export Commands

Command bundle for Adobe Fireworks
Aaron Beall 2011 - fireworks.abeall.com
Version 1.0.6

O Description:

An assortment of commands to export Fireworks designs to other formats:

» Export Pages and States - Exports both pages and states to files at the same time, with a customizable filename schema.

» Export Slices As Sprites ~ Exports slices combined as a single image, or each slice as an image with all states combined. Optionally
generates HTML and CSS for use as CSS image sprites.

» Export Styles As CSS - Exports all styles defined in the styles panel as CSS declarations.
» Export SVG - Exports document or selected elements as an SVG file.

EXport

http://fireworks.abeall.com/extensions/commands/Export/

Image Sprites #nav 3 { dackground-image uri(
LI T Y Y] #Fnav 3. home { background-pos 1)
voonoa #nav 3. home:hover { backzr
!"‘.‘ Pnsv 3. 3bout \ ’

ra T B



http://fireworks.abeall.com/extensions/commands/Export/
http://fireworks.abeall.com/extensions/commands/Export/
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The easiest way to use
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https://typekit.com/
https://typekit.com/

GO Ugle FO ntS More scripts About Analytics New to Google Fonts?

629 font families shown Word Sentence  Paragraph Poster co @
Preview Text: Grumpy wizards make ~ Size: 28px ~ Sorting: Trending ~

Filters:

All categories b Normal 400

» Thickness Grumpy wizards make toxic brew for the evil Queen and Jack.

» Slant

» Width Port Lligat Slab, 1 Style by Tipo B O Add to Collection
[X] Reset all filters/search
Script: Normal 400

Latin - Grumpy wizards make toxic brew for the evil Queen and Jack.
e Happy Monkey, 1 Style by Brenda Gallo B O Add to Collection
[Z] Show all styles

Normal 400

Grumpy wirzards make to=ic brem for Tl

Press Start 2P, 1 Style by CodeMan38 B DO Add to Collection

Google Fonts

http://www.google.com/fonts/

GRUMPY WIZARDS MAKE TOXIC BREW FOR THE EVIL QUEEN AND JACK.

Marcellus SC, 1 Style by Astigmatic = o Add to Collection


http://www.google.com/fonts/
http://www.google.com/fonts/

Keyamoon

Browse and select icons to download them or make a font. You may import SVG images or fonts too.

inporcons | m NRSRTERNE RSN ~ 1104 )

== |cOMoOON - Free @ykeyamoon) &

A S P in 5] Vi 14 ~ s » ) e = r~ = (O] JJ M
o 0 (29 B € @ & ¢ A « = ® () £ in it E E]
D B D iy r & Iy i) rg e = =) & @ ] o & -
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lcoMoon

http://icomoon.io/app/
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WebFontsD 74—/ \w7

W@ <% Jojd

ENESBI?7Web 727 FiziibL Ty
VR ~2012 %9 Web 7 £~ I
g » »

Wk Jea bl T YT

AN 7 e~}

WERMBAD Ty E TR TRERLEVWLD

------

& 7707

http://tech.nitoyon.com/ja/blog/2012/04/26/web-font-popularity/

hall2u.net

http://hail2u.net/blog/webdesign/mapping-to-private-use-area-is-not-a-perfect-answer.html
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Adobe Developer Connection [ADC] / Dreamweaver 7RO v /{—-t & — /

HTML5&CSS3 A P9 556[c] Graceful
Degradation & Polyfill
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Progressive Enhancement (707
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CSS Web Premium

Graceful Degradation & Po\yﬂH

http://www.adobe.com/jp/devnet/dreamweaver/articles/htmlSpack_css3_part6.html
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Sublime Text

Sublime Text is a sophisticated text editor for code, markup and prose.
You'll love the slick user interface, extraordinary features and amazing performance.

e No Demonstration e
base64.cc

void base64_encode( uint8_t = data, size_t ler, char * dst)
{
size_t src_idx = 9;
size t dst_idx = 9;
(; (src_idx + 2) < ler; src_idx += 3, dst_idx += 4)

{

uint8_t s® = datalsrc_idx];
uint8_t sl = datalsrc_idx + 1];
uint8_t s2 = data[src_idx + 2];

dstldst_idx
dst[dst_idx
dst[dst_idx
dst[dst_idx

charset[(s0 & 0xf¢
charset[((s0 &
charset[((sl1 &
charset[(s2 & @

(src_idx < ler)
{
uint8_t s® = datalsrc_idx];
uint8_t s1 = (src_idx + 1 < len) ? datalsrc_idx + 1] :

dst[dst_idx++] = charset[(s® & 0xfc) >> 2];
dst[dst_idx++] = charset[((s® & 2x03) << 4) | ((s1 & 9xf@) >> 4)];
(src_idx + 1 < ler|)
dst[dst_idx++] = charset[((s1 & 0x@f) << 2)];
}

E ecalacetlaw cnnloame

Sublime Text

http://www.sublimetext.com/

Cname thinoc r1icarc lave ahoiit Sithlime Tavt
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B ra c kets About Trylt Contribute Stay Informed

open-source code editor
built with the web for the web

Helpful without \

: . innovative
taking over :
With features like Live N S open
Preview and Quick Edit, 2 : B
Brackets streamlines | & focused
development without \ St enable

article { --

width: 13 eanepiopamn

getting in your way.

margin:

About Brackets

Brackets is an open-source editor for web design and development built on top of web technologies such as HTML, CSS and

JavaScript. The project was created and is maintained by Adobe, and is released under an MIT License.

Brackets

http://brackets.io/

TOOLS SHOULDN'T GET IN YOUR WAY

Rather than clutter your workspace with floating panels, toolbars and icons, Brackets focuses on providing “Quick Edit" in-line

viewre that nrenwnAde rantovi.concitive arroce favniircnntont withatit talkiinag vnir swrmsmsvy franm untir rad s
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C@ Adobe Edge Code CC (Preview)
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Edge Code

http://html.adobe.com/jp/edge/code/
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CSS Preprocessor
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$ gem install sass
$ mv style.css style.scss
$ sass --watch style.scss:style.css

About Tutorial Documentation Blog Try Online

Latest Release: Media Mark (3.2.10)

{style with attitude} What's New?

Sass makes CSS fun again. Sass is an extension of CSS3, adding nested rules, variables, mixins,
selector inheritance, and more. It's translated to well-formatted, standard CSS using the command
line tool or a web-framework plugin.

Sass has two syntaxes. The most commonly used syntax is known as “SCSS” (for “Sassy CSS”), and is
a superset of CSS3's syntax. This means that every valid CSS3 stylesheet is valid SCSS as well. SCSS D OWD.IO ad
files use the extension .ScCss.

The second, older syntax is known as the indented syntax (or just “.sass”). Inspired by Haml's # Editor Support
terseness, it's intended for people who prefer conciseness over similarity to CSS. Instead of brackets ' o o
and semicolons, it uses the indentation of lines to specify blocks. Files in the indented syntax use the . Development

extension.Sass. e S A

While the documentation on this site is mostly in the SCSS syntax, both syntaxes are fully supported ~ there is no functional difference
between them. Use the syntax you prefer.

Sass / SCSS

http://sass-lang.com/

.content-navigation { border-color: #3bbfce; text-align: right; margin: 2em 0;
border-color: $blue; color: #2bSeab; } }
color: } } table.hl td.In {
darken(Sblue, 9%); text-align: right;
} .border { li § }
naddina: Roy énnt |
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Write some LESS:

x-shadon(Bstyle, £c) when (iscolor(ec)) {
box-shadow: ’style €c;
-webkit-box-shadow: yle €c;
-moz~-box-shadow: . -

The dynamic stylesheet language. | )

w(@style, . ) when (isnumber( N A{
- I'( ) m( ? ? ? ));
LESS extends CSS with dynamic behavior such as | }‘ .
variables, mixins, operations and functions. : ' color: saturate(ébase,

5 border-color: lighten(

v { .box-shadow(

LESS runs on both the server-side (with Node.js
and Rhino) or client-side (modern browsers only).

version 1.4.1

changelog npm install -g less
lessc styles.less styles.css

overview usage language function reference source about fry it now!

1.4.0

We have released 1.4.0. This includes new features such as extends, the data-uri function and more maths
functions. See the changelog for a full list of changes.

There are some known breaking changes.

LESS

http://lesscss.org/

ALACUNACAL GLY GAAANA AN AW TY TVAODA AL a9 ow‘mwl-luj l“-lb\rl-o A ANALONy ARANANANAN. Jvu-l ARV VA W J VRARRAR VA VM-IJ SRONs Vil

modern browsers.

We have introduced a optional strictMath mode, where math is required to be in parenthesis, e.g.


http://lesscss.org/
http://lesscss.org/

Expressive, dynamic, robust CS5S

CSS needs a hero

body {

font: 12px Helvetica, Arial, sans-serif;
}

a.button {
-webkit-border-radius: Spx;
-moz-border-radius: 5px;
border-radius: Spx;

What if we could omit braces?

stylus

http://learnboost.github.io/stylus/

Selectors

Variables
Interpolation
Operators

Mixins

Functions

Keyword Arguments
Built-in Functions
Rest Params
Comments
Conditionals
iteration

@import

@media

@font-face
@xeyframes
@extend

url)

CSS Literal

CSS Style Syntax
Char Escaping
Executable

Emor Reporting
Connect Middleware
Introspection AP
JavaScript AP
CSS3 Extensions with
Nib

Try Stylus Online!

How about semi-colons?


http://learnboost.github.io/stylus/
http://learnboost.github.io/stylus/
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Reference Help Blog GetInvolved Install Q

“compass

is an open-source CSS Authoring
Framework.

Why designers love
Compass.

1. Experience cleaner markup without
presentational classes.
2. It's chock full of the web's best reusable
patterns.
. It makes creating sprites a breeze.
. Compass mixins make CSS3 easy.

. Create beautiful typographic rhythms.

O v AW

. Download and create extensions with

compass

http://compass-style.org/

Compass uses Sass.

Sass is an extension of CSS3 which adds nested
rules, variables, mixins, selector inheritance,
and more. Sass generates well formatted CSS
and makes your stylesheets easier to organize

and maintain.

P Cross-platform mobile

%7 ICENIUM development: Code in HTML5

Mobile development & JS - Build iOS & Android
Simplified apps
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Bootstrap 3 RC2  Gettingstarted CSS  Components  JavaScript  Customize

Bootstrap 3

Sleek, intuitive, and powerful mobile-first front-end framework
for faster and easier web development.

‘ Download latest BS3 ‘

Heads up! Downloads are pulled directly from the latest committed code on GitHub, and as a result our docs may at times be out of sync.

Bootstrap

http://getbootstrap.com/


http://getbootstrap.com
http://getbootstrap.com

wa Bourbon

A simple and lightweight mixin
library for Sass.

linear-gradi

(Vo]

CSS Output

$lucida-grande

font-family: "Lucida Grande", Tahoma, Verdana, Arial, sans-serif;

Bourbon
http://bourpon.io/

The mixins contain up-to-date vendor prefixes for support in modern browsers.

// Bourbon mixin with Sass /* Compiled CSS8 */


http://bourbon.io/
http://bourbon.io/

DRY



DRY: Don't Repeat Yourself
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Object-Oriented CSS

Hosted Welcome, Velocity Conference participants!

Play with these in Firebug to learn the basics. All the resources you need to get started are linked from the left navigation. Start by downloading the base files.
Exercises one and two can be completed in Firebug if you are comfortable with it. Then you can download the

Template finished file at the beginning of Exercise 3.

Grids

Module

Content (very alpha)

Downloads on Github

Velocity download
Alternate download

Stuck?

If you don't keep up with any of the exercises you
can view (and download) the finished examples
here.

Starting Template

Exercise 1: Template

Exercise 2: Grids

Exercise 3: Module Manipulation
Exercise 4 Module Creation

O0CSS

http://oocss.org/
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English | Pycckui

What is BEM Methodology

BEM stands for Block-Element-Modifier. It's a way to BEM gives useful patterns and methodological
modularize the development of pages. By breaking things recommendations on writing CSS, JavaScript, templates

into Blocks, being able to break those into Elements, and (and other web-related techs) in an extra-semantic way.

.
»
ZEUlelallniz elalualiZias JiZHel - Ealix) li-l‘- e ZINTalz> —Hali > = [ ) alfziVizliels’zlax = aNalZiisi™mrIalm (= =0»

BEM
http://bem.info/

« Simplifies the « Rapid involving new illustrated article.

development and team members
...... et G U B S o iy e iy e X1 18y ondoonnds Erall DEAA ~dasls
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Register for Workshop ~ GetSmackedl Sign in

SRrchitecture for ¢

A flexible guide to developing sites small and large.

ll xmwu mﬁ Wiscussion (n years®

“SMACSS is becoming one of the most useful

contributions to front-end discussions in years” *
I've been analyzing my process (and the process of those around
me) and figuring out how best to structure code for projects on a
larger scale. What I've found is a process that works equally well
for sites small and large.

Learn how to structure your CSS to allow for flexibility and

maintainability as your project and your team grows.

ide to developing
1l and large

Get smacked!

A flexible gu
sites sTMA

What is it?

What's in SMACSS?

http://smacss.com/

with CSS these days?! 4. Base Rules
5. Layout Rules
Get to know Scalable and Modular Architecture for CSS: 6. Module Rules
7 Qé¢ate Duloe
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AGOOD CSSAND SASS

ARCRITECTURE

FORMUCH BETTER CODING

5phECSSEEL 2T

http://www.slideshare.net/hiloki/a-good-css-and-sass-architecture
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Koala

a gui application for Less, Sass, Compass and CoffeeScript

compilation.

Koala is a GUI application for Less, Sass, Compass and CoffeeScript compilation, to help web
developers to use them more efficient.Koala can run in windows, linux and mac.

a t_u"ﬂr\lni;.(olh-e e ca
options:
less\styledess B ne comments
oos- W debug nfo
output style:
ii sass\style.scss
‘\-ﬂ# sass\test.sass

Koala

http://koala-app.com/

e Mac, 10.74
¢ Linux: 32bit/64bit
« Ubuntu: 32bit / 64bit


http://koala-app.com/
http://koala-app.com/




Preprocessing just got easier with Prepros
Enjoy the dead simple design & development workflow

File Types Auto Compile

Line numbers

haml.haml .
Use Compass

Output Style

Expanded

Prepros

http://alphapixels.com/prepros/

%8 Prepros2.3.2forWindows [l E¥ Prepros2.3.2for0SX10.7+ Jl & Install Chrome Extension
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{36} CodeKit

CodeKit

PROJECTS Styles Scripts Pages Images .t
! Crazy Cliem Bl /indexphp I

L My Website
] Steve This file do ¢ directly com: Check Symtax With

@ Do not compile directly

UNC = .
=,
/scripts/pageControllers When Processing

Concatenate, then minify

FRAMEWORKS

Bl VOKFramework y " Check Syntax

EE Twitter Bootstrap [scripts/storeController.coffee

store/storePage.haml
/. v ./ 3 "g
ﬁ [styles/about.sass
E [styles/main.less

styles/store.styl

CodeKit

https://incident57.com/codekit/
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. DOCS SUPPORT BLOG

Mixture. Rapid prototyping,

DOWNLOAD

static site generation and so much more

Mixture

http://mixture.io/
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Thank You!

I { fo.com/hiroshi.kuboki
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